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A  
The Rich See a Different 
Internet Than the Poor 

Ninety-nine percent of us live on the wrong 
side of a one-way mirror 

By Michael Fertik, Scientific American 2/18/13  

Imagine an Internet where unseen hands curate your 
entire experience. Where third parties predetermine 
the news, products and prices you see—even the 
people you meet. A world where you think you are 
making choices, but in reality, your options are 
narrowed and refined until you are left with merely the 
illusion of control. 

This is not far from what is happening today. Thanks 
to technology that enables Google, Facebook and 
others to gather information about us and use it to 
tailor the user experience to our own personal tastes, 
habits and income, the Internet has become a 
different place for the rich and for the poor. Most of us 
have become unwitting actors in an unfolding drama 
about the tale of two Internets. There is yours and 
mine, theirs and ours. 

Here's how it works. Advertising currently drives the 
vast majority of the Internet industry by volume of 
revenue. Silicon Valley is excellent at founding and 
funding companies that give you free apps and then 
collect and sell your data when you use them. For 
most of the Internet's short history, the primary goal of 
this data collection was classic product marketing: for 
example, advertisers might want to show me Nikes 
and my wife Manolo Blahniks.  

But increasingly, data collection is leapfrogging well 
beyond strict advertising and enabling insurance, 
medical and other companies to benefit from 
analyzing your personal, detailed “Big Data” record 
without your knowledge. Based on this analysis, these 
companies then make decisions about you—including 
whether you are even worth marketing to at all. 

 

 

 

 
 

As a result, 99 percent of us live on the wrong 
side of a one-way mirror, in which the other 1 
percent manipulates our experiences. Some laud 
this as “personalization” which sounds innocuous 
and fun, evoking the notion that the ads we see 
might appear in our favorite color schemes. What 
we are talking about, however, is much deeper 
and significantly more consequential. 

For example, federal regulations make it illegal to 
discriminate in pricing access to credit based on 
certain personal attributes. But, as Natasha 
Singer recently reported in the New York Times, 
technical advances in mining online and offline 
data have made it possible to skirt the spirit of 
the law: companies can simply not make any 
offers to less credit-attractive populations. If you 
live on the wrong side of the digital tracks, you 
won't even see a credit offer from leading lending 
institutions, and you won't realize that loans are 
available to help you with your current personal 
or professional priorities. 

For the past decade, e-commerce sites have 
altered prices based on your Web habits and 
personal attributes. What is your geography and 
your past buying history?  Cont’d on page 6. 
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Meetings:  Lomita Veteran’s Hall,  
1865 Lomita Blvd, Lomita   

Mail:  PO Box 432, Redondo Beach, CA  
90277-0432 

Phone:  (310) 644-3315    
Email:  info@sbamug.com 

Website: http://www.sbamug.com 
 

Welcome to the SBAMUG 
South Bay Apple Mac User Group  

 

Members, friends and 
colleagues are invited 
to attend our monthly 
meetings. The $35 
annual membership 
dues entitle you to 
receive this monthly 
newsletter by mail or 
online, plus many 
more benefits (page 
8).  To become a 
member or get more 
info please check our 
website.  

 
 

 

Officers & Volunteers: 
 

President:  Arnold Silver            VP:  Vacant 
Secretary:  Wayne Inman       Treasurer: CW Mitchell 
Directors at Large:  Dave Nathanson, Margaret Wehbi, 
Pam Townsend, LJ Palmer 
PD Disk Editor:  Jim Pernal     Membership: CW Mitchell   
Programming: Bob Goodman      Greeter:  Vacant 
Server Director:  Dave Nathanson 
Newsletter:  Pam Townsend, Pete Myers, Bill Berks 
USPS Liaison:  Don Myers  
Refreshments:  Member contributions 

Membership Report –129 members 
Please wear membership card as your name tag  

 

Welcome new members:  . Barbara Mathieu, Hillary 
Watts, Lonna Lynn. 
 

Thank You Member Renewals:  Fran Pullara, Philip 
Gruskin, Robert Goodman, Walt Fierberg, Alice 
Patterson, Burt Belzer, Paul Curry, Victor Kosuda, John 
Baskett. 
 

Contact Membership Chair CW Mitchell for any 
corrections: cwmitchell@sbamug.com.  Renew at the 
meetings or by mail.  

 
 

 

SBAMUG Monthly Calendar  
March 27:  Working with Mt. Lion 

April 24:  Media Center 
***Read this newsletter online (active hyperlinks!) at http://www.sbamug.com/newsletter.html ***  

 
 

  
 

THE SOUTH BAY MUG (ISSN 1058-7810) is published monthly for $35 per year by South Bay Apple Mac User Group, 2550 Via Tejon, Suite 3J, 
Palos Verdes Estates, CA 90274. Periodicals postage paid at Palos Verdes Peninsula, CA and at additional mailing offices.  POSTMASTER: 
Send address changes to THE SOUTH BAY MUG, P.O. Box 432, Redondo Beach, CA 90277-0432. 
The South Bay MUG is published by the non-profit South Bay Apple Mac User Group. Excerpts may be reprinted by user groups and other non-profit media. Credit 
must be given to SBAMUG and the author. In addition, a copy of all reprinted materials must be sent to us at the above address. The South Bay MUG is an 
independent publication not affiliated or otherwise associated with or sponsored or sanctioned by Apple® Computer, Inc. The opinions, statements, positions and 
views stated herein are those of the author(s) or publisher and are not intended to be the opinions, statements, positions or views of Apple® Computer, Inc. 

SBAMUG Meeting Format: 
 

6:30—7:30 p.m.  Questions & Answers and Sharing:   
Everyone is welcome, beginners encouraged  
7:30—7:45 p.m.  ‘iSocial’ – shoot the Mac breeze 
with others over a cookie   
7:50—9:00 p.m.  Announcements and Program 
 

**Refreshments provided; donations appreciated!  
 

Submit suggestions for topics or speakers, or articles, 
ideas & original artwork for this newsletter by the last 
Wednesday of each month. Articles may be edited to fit 
space. Submit to: ptownsend@sbamug.com 
 

Other Meetings: 
• 1st Sat. each month – SBAMUG Core Group, 10 a.m. 

Join Google+  SBAMUG community, or email: 
info@sbamug.com.   

• Special interest groups (SIGs): Ask at the meetings or 
email: info@sbamug.com 

• Last Sat. each month - Northrop Grumman-Ham Radio 
& Computer Swap Meet, 7--11:30 a.m. Meet at SE 
corner of Marine/Aviation Blvd, Redondo Beach 

• Los Angeles Portable Users Group: Mac OS X, iPhone, 
iPod, MacBook, etc., http://www.lapug.org/ 

• Find more:  http://www.apple.com/usergroups/ 

 Lomita Veteran’s Hall, 
1865 Lomita Blvd, Lomita 
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PD-CD JIM PERNAL 
MARCH 2013 PUBLIC DOMAIN CD 

App of the Month 
Video Editing 

Cute Cut  
Do you want to create your own unique 
movie? Just draw it by yourself with Cute 
Cut.  Compatible with iPhone/iPod touch 3rd 
generation or later, iPad, iOS 4.3 or later. 
Optimized for iPhone 5.   
http://cutecut.mobivio.com/ 
https://itunes.apple.com/us/app/cute-
cut/id583555212?mt=8&ign-mpt=uo%3D2 
 
Video Edit 
Video editing on iOS, easy-to-use interface, 
but it has limits. All you can do is stack 
movie clips from your video archive together 
into one bigger production.  iPhone, iPad.  
 
Magisto  
Use your photos to make cool movies.  
Compatible with iPhone, iPod touch, iPad. 
Requires iOS 4.3 or later. Optimized for 
iPhone 5. 
 
For more info, see The New York Times: 
https://itunes.apple.com/app/magisto-video-
editor-free/id486781045 
http://www.nytimes.com/2013/02/07/technol
ogy/personaltech/a-review-of-video-editing-
apps-for-the-smartphone.html?_r=0 
 
YouTube adds Magisto automatic 
video editing tool 
by Laura Locke, 9-21-11, CNET  
 
Now any video being uploaded to YouTube 
can be edited automatically. No manual 
intervention is needed--just one click of a 
button-- and Magisto's tool instantly "finds" 
the  best scenes in your video and cuts out the 
blurry, bad and boring bits. Music and effects 
(wipes, transitions, titles, and  fades) can also 
be added with two button clicks. The tool is 
dead simple to use as it literally walks you 
through the editing "process" in seconds.  
http://news.cnet.com/8301-1023_3-
20109832-93/youtube-adds-magisto-
automatic-video-editing-tool/#! 
 
 

 
 
 

Nine items this month. A couple of “one trick ponies” that 
you might find useful   
 
CarMaintenance_1_7_2.zip A program to keep track of 
your car maintenance.  You can store car info, VIN, and 
pictures.  Has reminders to take the car in for service and has 
a gas log.   Intel only OSX 10.6 or better.  Shareware $10.00  
 
CDRViewer.zip One trick pony application to view 
Coreldraw files.  Something even GraphicConverter can’t 
handle.  Intel OS X 10.6.  Free  
 
displaperture140.dmg The other one trick pony to bring 
back rounded screen corners.  Free.  Intel OSX 10.6.  
 
Easy Books 2.6.15.zip Double entry accounting program. 
Shows profit and loss balance sheet.  Technically free, but 
beyond 120 entries requires $29.95 purchase, and invoicing 
and time tracking add-ins are also paid extras.  Intel and OSX 
10.7 minimum are the requirements.   
 
gimp-284-nopython-dmg-1.dmg Open source photo editor. 
Free.  Now Mac native.    Has plug in capabilities. OSX 
10.6.8 or higher Intel.  
 
passwordhelper_1.3.zip  Free utility program that will 
create good passwords and also help you learn you password 
by typing it blind and seeing if you correctly entered it. OSX 
10.7 or higher Intel.  
 
seamonkey-ppc-2.16-RELEASE.app.zip The PowerPC 
version of this web browser.  Has email and newsreader 
clients built in.  Based on the Monzilla engine.  Free.  OSX 
10.5 required.  
 
TextWrangler_4.5.dmg  Text editing program. The “little 
brother” of the well regarded BBEdit program. Free.  Intel 
OSX 10.6 minimum.  
 
TuneSweeper.dmg  Program to find duplicates in your 
iTunes library.  This program will also so tracks that are in 
your iTunes library, but don’t exist as real files on your hard 
drive.  OSX 10.7 or higher and Intel required.   Shareware 
$19.99 
 
CD for this month will be at the April 2013 meeting, labeled 
as the March-April  CD.  See you at the March meeting.  
Jim Pernal PD Editor 
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Consumer Reports Says 
iPhone 5 is the Worst of the 
Top Smartphones 
By Henry Blodget, Business Insider  

One of the reasons Apple's stock has gotten 
clobbered lately is that many people think 
Apple has lost its edge in its most important 
product line: smartphones. 

The iPhone has been such a mind-boggling 
success that it drives more than half of 
Apple's overall profit. And for most of the past 
five years, Apple has had a lock on the "best 
smartphone in the market." 

In recent years, however, competitors have 
caught up with the iPhone. Some reviewers 
think Samsung's new phone is superior to 
Apple's latest phone. And many people 
expect Samsung to leap ahead when the new 
Galaxy S4 comes out this spring. 

Another respected product reviewer, 
Consumer Reports, agrees with those who 
think Apple has lost its edge. 

In fact, Consumer Reports' conclusion is 
even more depressing for Apple fans. 
Consumer Reports actually rates the iPhone 
5 the worst of the top smartphones.  CR 
doesn't spell out the reasons for its numerical 
ratings (yet), but the results are still startling. 

Below is the summary box of CR's lab tests, 
in the February issue. The numerical ratings 
are close together, but they're unequivocal. 

As you can see, on AT&T and Sprint, the 
iPhone 5 is rated behind two phones: 
*  The LG Optimus G (Android) [The what?] 
*  The Samsung Galaxy S III (Android) 
    
On Verizon, meanwhile, the iPhone 5 is rated 
beneath at least three smartphones: 
* The Motorola Droid Razr Maxx (Android, 

and owned by Google) 
* The Motorola Droid Razr HD (Android, 

and owned by Google) 
*  The Samsung Galaxy S III (Android) 
 
Ranked behind Google phones in addition to 
Samsung phones? That must feel like a bit of 
a slap in the face.  Apple had better be 
cranking on the iPhone 6... 
 

http://www.businessinsider.com/consumer-
reports-iphone-5-2013-1; Jan. 4, 2013 
 

How to Watch Flash Videos on iPad 
Posted by Ivan Cook, www.iskysoft, 1/24/13 
 
Here's how to watch flash videos on iPad. Apple doesn't support 
Adobe Flash Player or even Adobe's Flash plugin.  
 
Method 1: Use another browser to watch flash video on iPad 
 

Skyfire is a web browser frequently talked about by iOS users  as a 
great place to play flash videos on iPad, iPhone and iPod touch. For 
$2.99 it can be downloaded in iTunes. Skyfire supports more than 
200,000 websites and new ones are added daily. But it will take 10-
20 seconds to start each flash video on your new iPad, and you are 
unable to play flash games and run flash apps with Skyfire – it’s only 
for watching flash video. 
 
Method 2: Convert flash video to iPad 
 

While your flash videos have been downloaded on your Mac, you 
actually can use SyncPod for Mac to convert and transfer the flash 
video to iPad directly: 
 

Note: If you haven’t downloaded the flash videos yet, you can use iTube 
Studio for Mac. This Mac app can download and convert any web video 
including flash videos to iPad, iPhone, iPod and more. Detailed info; User 
Guide of iTube Studio for Mac. 

 
1.  Download SyncPod and open it, connect your iPad to Mac.  Then 
you will see the main interface of the SyncPod, where you can see 
the iPad items under categories on the left part, iTunes library and 
local files on the right. 
 

2.  Find your flash video on the right side on the right pane of the 
SyncPod interface, then select them and directly drag them to the 
left; after that, you will see the videos listed in your iPod library on the 
device. 
http://www.iskysoft.com/apple-ipad/watch-flash-videos-on-ipad.html 
 

Download YouTube Videos to iPad on Mac OS 
 

iTube Studio for Mac provides excellent performance in downloading 
YouTube videos on Macs running Mac OS X 10.5 and above. It’s 
professional in downloading on Mac and can download web video 
including YouTube to iPad or some other devices and players easily. 
 
1. Download and install iTube Studio. It will add a download button to 
all video on supported sites so you can download online video in one 
click. 
2. Open Safari and find the YouTube video and play it, on the top of 
which you will see a download button, click the button. The YouTube 
video will be saved to the Downloaded tab of the iTube Studio after 
the downloaded; then you can: 
3. Convert YouTube video to iPad: View downloaded video in the 
Downloaded tab, and click the Convert button to choose the iPad 
preset offered, then click OK to start converting YouTube video to 
iPad supported format. Be sure to check "Export to iTunes" option.  
4. When YouTube to iPad conversion is complete, the converted 
YouTube video will be added to the iTunes library automatically if 
"Export to iTunes" is checked when marking settings. Otherwise, you 
can import the converted YouTube video to your iTunes library. Next, 
connect your iPad to Mac and transfer YouTube videos to iPad via 
iTunes as you used to do for file sync. 
http://www.iskysoft.com/apple-ipad/download-youtube-videos-to-
ipad.html 
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The Five: Smartphone Security 
By Scott Wilson, Los Angeles Times  2/10/13 
 
Your smartphone carries a lot of things that an identity 
thief would love to have: stored passwords to online 
accounts, banking information, email addresses and 
phone numbers. How can you make sure your phone's 
private data stays private? Adam Levin, cofounder of the 
Identity Theft 911 website and former director of the New 
Jersey Division of Consumer Affairs, offers these tips: 

•  Lock your phone with a password. It's the most basic 
security step, but one that some people skip. Yes, a 
hacker could break in anyway, but they may not want to 
bother. "Most bad guys will simply move on to the next — 
easier — target," Levin noted. "It's a lot easier for a thief to 
steal a smartphone with no password than it is to work on 
cracking your phone." 

•  When online shopping, use an app rather than your 
browser. Most major retail sites offer dedicated shopping 
applications that help shield you from fraudulent phishing 
sites and other scammer tricks, Levin said. Just be sure 
it's the official app before you download it. 

•  Log out. When you're done checking your credit card 
balance or checking account, be sure to sign out. "And 
never click the box asking the app to save your user ID or 
password," Levin suggested. 

•  Connect to Wi-Fi only when you need it. Turn off the 
feature on your phone (or laptop or tablet) that 
automatically connects you to any nearby Wi-Fi network, 
Levin recommended. If you don't, "hackers with the right 
software can easily hack your phone." And close your 
Bluetooth connection when you're done. 

•  Delete all personal data before selling or donating your 
old phone. Look in the settings for an option to "erase all 
content," "factory data reset" or something similar. 
 

scott.wilson@latimes.com 
http://articles.latimes.com/2013/feb/10/business/la-fi-five-
phonesafe-20130210 
 
 

Shortcut Keystrokes in OS X 
By Phil Russell, Corvallis MUG 
 
Is this you? You close a window or document  
by clicking the close box at the upper left of  
the window or document. You create a  new 
folder by mousing to the File menu and 
selecting New Folder. Check out the list of 
useful shortcuts in this article. Even if you adopt 
a only a few, you will be more efficient.  
 

http://cmug.com/tutorials/Keyboard_Shortcuts.pdf 

The return of "Whoa, I have a 
really old file, how do I open it!?" 
 

By Christopher Breen@BodyofBreen, Mac 
911, MacWorld, 1/16/13  

Reader Karl Lacher is the latest to inquire about very old 
files that seemingly can’t be opened with a very new 
Mac. He writes: 

Genealogy is my hobby and I have many old 
Microsoft Word 5 documents stored on my iMac. 
How can I recover the text from these files with my 
current copy of Microsoft Office 2011?  

As you can probably judge by this article's title, this is 
well-worn territory. And, regrettably, the path is even less 
smooth than it once was. But give this a go. 

Launch Word 2011 and choose File > Open. Navigate to 
the document you want access to and click the Open 
button. With luck, your file will open with something close 
to its original formatting. (If it doesn’t, make sure you 
have the latest version of Office—choose Help > Check 
for Updates.) I tried this with a Word 5 file provided to me 
by Twitter follower Ben Smith (@benptooey) and it 
opened without including garbage characters. This is 
hardly an ideal solution as it requires that you open each 
file individually, but at least it works, which is more than I 
can say for some other methods. 

And what are those other methods? Unlike in days of 
old—when you could purchase a converter utility—those 
methods are now far more limited. For the most part you 
can attempt to open the files in a text editor or within an 
open-source suite such as NeoOffice or LibreOffice.  

When opening my test file with TextEdit and these two 
applications I saw a fair helping of random characters. 
With the judicious use of a Find and Replace command I 
was able to clear out a lot of the junk, but it’s not the kind 
of thing that you want to do with more than a couple of 
documents. 

The lesson learned here is that it pays to save your files 
in formats likely to be supported over time. Trusting that 
a single company—even one as large as Microsoft or 
Apple—will produce a proprietary file format that lasts 
through the ages isn’t a good bet. Use something of a 
more universal nature—Rich Text Format (RTF) or PDF, 
for instance—and there’s a better chance your data will 
be there when you (or your descendants) are old and 
gray. 

Note: I know this will lead to "But what about Apple 
Works' database files!?" Seriously. Don't go there. Don't. 
http://www.macworld.com/article/2025389/the-return-of-
whoa-i-have-a-really-old-file-how-do-i-open-it-.html 

 

 



 
6 

  

The Rich, continued from page 1  
 

How did you arrive at the e-commerce site? What time of day are 
you visiting? 

An entire literature has emerged on the ethics, legality and 
economic promise of pricing optimization. And the field is 
advancing quickly: last September, Google received a patent on 
technology that lets a company dynamically price electronic 
content. For instance, it can push the base price of an e-book up 
if it determines you are more likely to buy that particular item 
than an average user; conversely, it can adjust the price down as 
an incentive if you are judged less likely to purchase. And you 
won't even know you are paying more than others for the exact 
same item. 

These blind walls also appear in our digital political lives. As Eli 
Pariser has observed, the Internet shows us “what it thinks we 
want to see” by serving up content that matches the hidden 
profiles created about us based on our daily online interactions. 
This behind-the-scenes curation reinforces our political points of 
view through online “echo chambers” that affirm, instead of 
challenge, what we already believe to be true. As Harvard 
University scholar Cass Sunstein has written, liberals and 
conservatives who deliberate questions openly only with people 
of the same political stripe become more confident and extreme 
in their views. 

Segregation and separation are on the rise. The fun of 
personalization has a dark side. 

Michael Fertik is founder and CEO of Reputation.com, which is 
a member of the World Economic Forum Global Agenda Council 
on the Future of the Internet.  Article was originally published as 
“A Tale of Two Internets.” 
 http://www.scientificamerican.com/article.cfm?id=rich-see-
different-internet-than-the-poor 

 

 

Printers, Inks & More 
 
A big thanks to Don Baker of Klassic 
Specialties for an informative talk last 
month.   
 
A few takeaways: 
• Paper quality is a big consideration for 

good photos.   
• Epson printers provide higher quality 

photos, all other things being equal, due 
to the ability to produce higher 
resolution prints.   

• Use paper and inks compatible with 
your printer.   

• Ink jet printers of various prices tend to 
provide similar quality prints.   

• Refilled cartridges may not work due to 
a chip that senses the cartridge is not 
new, unless you override and trick the 
printer into believing you are using a 
new cartridge.  

 
Check out Klassic Specialties, 13337 
South St., #212, Cerritos, 90703  
(562) 865-2988 
http://www.klassicspecialties.com/    

i Thoughts: Mobile and Mac OS X 
 
I ran across this little app, iThoughts, while noodling around in 
productivity apps. It lives in the ‘mindmapping’ universe, and 
although we do it all the time in our minds, on the back of an 
envelope, or more formally at work, you might not have known 
what it was called. In the iTunes store you can get iThoughts for 
iPhone $7.99, iThoughtsHD for iPad $9.99, and MyThoughts for 
Mac $49.99.   
 
A mind-map is a free-form way to collect and organize ideas. 
You enter words and phrases, usually contained in geometric 
shapes, then arrange and connect them within a workspace—
the map—to define their relationships. 
 
It looks fairly easy to use, in the tutorial in the first website 
below. Simply start by brainstorming and jotting down some 
thoughts, without worrying about the end product. These can 
then be moved around in a nonlinear manner to produce the 
map.  http://www.ithoughts.co.uk/Start/Welcome.html 
http://www.macworld.com/article/1162266/from_brainstorm_to_outline_
why_i_use_opml.html 
 
 
You can find them in the iTunes store. 
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The Raspberry Pi works best with an HDMI-
compatible monitor and USB keyboard and mouse. It 
is powered via a standard USB cable — just like the 
one that charges your phone — and it includes an 
audio-out port for connecting a set of speakers, plus 
an RCA jack if you don’t have a digital TV or monitor 
available.  

There is no on-off switch. To turn it off, you simply pull 
out the power cable.  

The Raspberry Pi will not do much out of the box. 
Because it has no onboard storage or operating 
system, you will need to copy the necessary software 
to a high-capacity SD memory card. A four-gigabyte 
card usually works well, but you may want more if you 
plan on loading applications or games.  

There are a number of available operating systems 
for the Raspberry Pi. On the official Web site, 
raspberrypi.org, you’ll find something under 
downloads called Raspbian, a Raspberry-flavored 
version of the Debian operating system that includes 
tools for beginners. Raspbian uses an interface that 
will be familiar to users of Windows or Linux.  

Adafruit has its own version of the Pi operating 
system called the Raspberry Pi Education Linux 
Distro at learn.adafruit.com. It comes with a child-
friendly browser.  

Also available are programs that you can use to add 
additional features to the Raspberry Pi, including Wi-
Fi support (an add-on peripheral is required) and 
hardware controllers for connecting your Pi to 
sensors, motors and more.  

Truly adventurous Raspberry Pi fans can even turn 
the product into a small home media center. Because 
the Pi has a powerful graphics chip on board, users 
have been able to stream video and photos to their 
big-screen TVs using little more than a Pi and a Linux 
program like RaspbMC at www.raspbmc.com. This 
fully-featured media center lets you stream video from 
a hard drive on the network and supports AirPlay, 
Apple’s proprietary video and audio streaming 
system.  

Mr. Upton said the plan was to develop the Pi’s 
software rather than the hardware. “If you improve the 
software, everyone can use it,” he said. “If you 
change the hardware, you leave a million buyers 
behind.”  

http://www.nytimes.com/2013/01/31/technology/perso
naltech/raspberry-pi-a-computer-tinkerers-
dream.html?src=me&ref=general&pagewanted=print 
 

A Tiny Computer Attracts a Million 
Tinkerers 
By JOHN BIGGS, Scientific American 1/30/13 

Raspberry Pi may sound like the name of a math-based 
dessert. But it is actually one of the hottest and cheapest 
little computers in the world right now. Almost one million 
of these $35 machines have shipped since last February, 
capturing the imaginations of educators, hobbyists and 
tinkerers around the world.  

The story of the Raspberry Pi begins in 2006 when Eben 
Upton and other faculty members at the University of 
Cambridge in Britain found that their incoming computer 
science students were ill-prepared for a high-tech 
education. While many students in the previous decade 
were experienced electronics hobbyists by the time they 
got to college, these freshmen were little more than skilled 
Web designers.  

Easy-to-use, modern PCs hide most of the nuts and bolts 
behind a pleasing interface. Mr. Upton posited that parents 
did not want their children to destroy their expensive 
computers by experimenting with their insides. But a 
cheaper machine would be fair game for messing around.  

The Raspberry Pi — about 3 inches by 2 inches and less 
than an inch high — was intended to replace the 
expensive computers in school science labs. For less than 
the price of a new keyboard, a teacher could plug in the Pi 
and connect it to older peripherals that might be lying 
around. But because Pi initially ran only Linux, a free 
operating system popular with programmers and 
hobbyists, students would have a learning curve.  

The Raspberry Pi Foundation began selling the computers 
in February of last year. They soon could not keep them in 
stock.  “We honestly were thinking of this as a 1,000- to 
5,000-unit opportunity,” Mr. Upton said. “The thing we 
didn’t anticipate was this whole other market of technically 
competent adults who wanted to use it. We’re selling to 
hobbyists.”  

Now every primary school in the world can take pictures 
from near space,” Mr. Upton said. “You give people access 
to this tool and they do great things.”  

Picking up a Raspberry Pi is not as easy as popping into a 
store. The Pi is so popular that many distributors are 
constantly out of stock. It is also difficult to find them 
online. 
 
The Pi costs $35, or $25 for an older model, and comes as 
a bare circuit board. Leaving the defenseless little thing 
unclothed is tantamount to Pi abuse, so you should also 
pick up a plastic enclosure.  Adafruit sells clear plastic 
enclosures for $15, and Polycase.com sells a solid, 
opaque plastic case for $17. 
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SOUTH BAY APPLE MAC USER GROUP 
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SBAMUG Membership Application 
South Bay Apple Macintosh User Group provides you with a local source of shared 
knowledge & experience through monthly meetings, trainings & monthly newsletter. 

 
Individual & family membership: $35/year payable to SBAMUG 

o  New Member          o  Member Renewal 
Name:_______________________________________________________ 
Address:_____________________________________________________ 
City:__________________________ State:______ Zip:________________ 
Phone: (________)____________________________________   
Email Address:________________________________________________ 
Special interest:_______________________________________________ 
Model of Macintosh you use most:_________________________________ 
How did you hear about SBAMUG:________________________________ 
Comments:___________________________________________________ 
____________________________________________________________ 

Signature:_______________________________________________   
Date: __________________________ 

Bring your Application and Fee to our General Meeting  
at Lomita Veteran’s Hall, 1865 Lomita Blvd., Lomita.   

 Or Mail to:  SBAMUG, PO Box 432, Redondo Beach, CA 90277-0432 

Join, Renew or Give 
a Gift of a SBAMUG 

Membership! 
For only $35/year you get: 

• Monthly meeting program 
• E-mail group help  
• Monthly newsletter  
• Use our Wiki  
• Free web space & e-mail on 

our server 
• Build your own website 
• Create your own blog  
• Special merchant discounts  

$$$ 
• Occasional swaps, free 

software, raffles  
http://www.sbamug.com/join.html 

Or, contact Membership Chair  
CW Mitchell at 

cwmitchell@sbamug.com  
 

PERIODICALS 


